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INTRODUCTION 

 

Wise Timetable is professional university and school scheduling software. It enables so many things to its 

users, such as manual and automatic course scheduling in multiple weeks (and in every week it can be 

different), web access and publishing by only one click, even most complex and largest timetables can be 

handled very easily, etc.  

 

All of modules are already included in the license and software is suitable for all kinds of high educational 

institutions – universities, colleges, primary and secondary schools, tuition schools and further education 

institutions.  

 

It is more than simple – by data entry all work is already done, software optimizes the whole schedule in 

10 seconds! Wise Timetable software is made to meet any needs of any kind of educational institutions 

because it was made and updated according to direct requests and demands of so many educational 

institutions that already use Wise Timetable.  

 

Therefore, our team tries to meet and satisfy all of those needs in order to have all of customers satisfied 

and works hardly to innovate and implement new functionalities and options in the software in order to 

have even better product for timetabling.  

In this new version 5, there are a lot of new things, options and possibilities with program as for example 

easier replacement of terms, iCalendar incorporated in e-mails with timetables, option to disable some 

term, and a lot of other options released which you can notice within this whole paper, starting 

immediately from the very first heading. 

 

Download demo version 5 on our official website and try Wise Timetable totally for free!  
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Keyboard shortcuts 
 

We revised keyboard shortcuts available in Wise Timetable – especially for function keys. Now, some very 

often used screens are accessible also with function keys. Here is the list of all function keyboard 

shortcuts: 

F1 - content sensitive help 

F2 – Settings  Miscellaneous 

F3 – Edit courses (opens select courses screen) 

F4 – Room view – overview of all the rooms 

F5 – Select View by Room – main view 

F6 – Select View by Lecturer – main view 

F7 – Select View by Group – main view 

F8 – Select View by Course – main view 

F9 – Lecturer View – overview of all the lecturers 

F10 – Plan final exams 

F11 – Invoke »Full screen edit« screen (popularly »Magnetic Board«) 

F12 – Invoke »Substitutions« module (Cover planning) 

SHIFT + F10 – Untouched reservations: make all reservations made on the web »fresh« - signed as »new«, 

so when editing different timetable you can import them again as »new« 

CTRL + F10 – manual check for modifications in database – new reservations,… Shows history log screen. 

This will not work if database is »Deactivated« previously in History log screen 

SHIFT + F11 – reload all the language settings, color schemes, etc… So, if you changed these configuration 

files while program is running, you can refresh it all here. 

SHIFT + F12 – generate automatically all the web passwords for professors. If password already exists it is 

NOT overwritten. In directory c:\ProgramData\WiseTimetable the file TutorPasswords.txt is created in 

order to let you collect passwords in one place (and inform professors if you like). The file looks like this: 

1. GILBERT JAMES: GILBERTJ489 

2. WEBB EDWARD: WEBBE604 

3. WILLIAMS ELLEN: WILLIAMSE963 

4. COLWELL RITA: COLWELLR166 

5. YORKE ROBERT: YORKER326 

…. 
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Passwords are created as combination of surname, first letter of the name and random number at the 

end. 

CTRL + F12 – generate automatically all the web passwords for groups. If password already exists it is NOT 

overwritten. In directory c:\ProgramData\WiseTimetable the file TutorPasswords.txt is created in order to 

let you collect passwords in one place (and inform students if you like). The file looks like this: 

1. AFM1-1: AFM11232 

2. AFM1-2: AFM12380 

3. AFM1-3: AFM13311 

4. BAM1-1: BAM11273 

… 

Passwords are created as combination of group name and random number. Delimiters and special 

characters are always ignored. 

SHIFT + INSERT – this is the same as SHIFT + F12 but passwords are always forced to be overwritten even if 

there is defined password 

CTRL + INSERT – this is the same as CTRL + F12 but passwords are always forced to be overwritten even if 

there is defined password 

RIGHT ARROW – shift week slider to the right 

LEFT ARROW – shift week slider to the left 

At groups screen (Edit  Groups) you can press: 

Enter: to confirm input for all groups 

Double click on group: to edit table cell (like group name or email…) 

When table of groups is selected you can press first letter of »Edit« button (different name in different 

languages and software automatically recognize what is first letter for particular – current language used) 

– for editing of groups. 

CTRL + R - change mode to reference mode – in this case when you select some course on the main screen 

and then change view (by pressing F5-F8 or selecting it from menu) then corresponding room or 

corresponding professor is automatically selected in other view 

CTR + R - again – returns to SWAP mode – thus enabling moving course across the main screen (these 

modes are visible by showing »REF« or »SWP« sign at bottom right of the main screen. 
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1. Editing reservations from the main screen 
 

To edit reservation from the main screen make right mouse click on the reservation and you will be able to 

see 3 new options (before this was dimmed for reservations). New options are: Edit, Edit this week and 

Delete. 

 

 

 

Edit functions leads directly into reservation edit screen. Before this was possible only by editing 

corresponding entry – Room, Lecturer, Group, etc. 

When delete only for this week, reservations will be splitted into two parts (before and after this week) – 

or remain in one piece if this is the first or the last week of the reservation duration 
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2. Wise Timetable supports Portuguese language 
 

With this version Wise Timetable supports Portuguese language including PC application, web modules 

and help.  

 

 

 

3. New system for data recovery 
 

There is complete new system for data recovery if something goes wrong with the computer all 

application (or accidentally deletion of data). Software now save the file every 8 minutes in background 

into recovery file. This saving is not visible to user and is done by involving separate thread in Windows 

system – making everything in background. Not only one recovery file is saved but 9 of them – effectively 

covering period of 9 x 8 latest minutes of work and one file from yesterday (the name of that file contains 

»OLDFILE«). So user can pick from various stages of edited data. Recovery files are complete xml files – 

containing complete timetables. These files are stored in directory c:\ProgramData\WiseTimetable (or on 

XP systems – still supported by the product -  in instllation directory/config). Here is example of these 

recovery files: 
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4. Better order of lecturer’s name/surname in exporting into PDF files 
 

Now exporting into PDF files takes care about proper order of Lecturer’s name/surname. User can choose 

format of displaying lecturer’s name. This is defined in Settings  Miscellaneous  View. 
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5. Screen options 
 

5.1. New ways of exiting the screen 
 

Now all screens in Wise Timetable system can be exited by pressing ESC or ENTER keys. Rare expections 

are screens like Course selection screen – because ENTER in that case goes into editing of the Course, View 

Rooms and View Lecturers. 

5.2. New ways of entering into editing screens 

Now F12 keyboard shortcut is changed to different functionality - when on the main screen choose View 

you want and press F12 and edit screen for chosen view will open. Before this was possible only by going 

into menu Edit  Rooms/Lecturers/Programs/Subject Areas/Groups/Courses/Students. 

  

Choose Vew by Room, choose specific room and press F12 key and edit screen for that room will be 

opened. 

Choose View by Lecturer, choose specific lecturer and press F12 key and edit screen for that lecturer will 

be opened. 

Choose View by Group, choose program, subject area year, specific group and press F12 key and edit 

screen for that group will be opened. 

Choose View by Course, choose program, subject area year, specific course and press F12 key and edit 

screen for that course will be opened. 

 

6. Edit Reservations 
 

Edit Reservations screen is available at Tools Edit Reservations. We made this screen for better handling 

reservations – in order to delete many reservations at once. It is possible to choose to delete according to 

dates or according to content (text description inside the reservation): 
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7. New procedure for users which work on different programs 
There is new procedure introduced for concurent users which work on different programs. With this 

option we publish to central database only those schedules which are defined for my local computer. With 

this procedure we do not have to wait for other user to finish their timetable editing because of locked 

database – because we publish only programs which are edited on local computer. This procedure is 

possible only if programs are really distinctive and no many overlapping schedules are from different 

programs. For each computer we define list of programs in text file (each program name in separate lines) 

named: syncsPrograms.txt stored in directory c:\ProgramData\WiseTimetable.  This file can be accessed 

from two places: Data  Sync schedules and Settings  Miscellaneous  General  syncsPrograms.txt. 
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8. Conflict window can be resized 
 

In order to show longer lists at once Conflicts window can now be resized and window content is resized 

accordingly. 

 

 

 

9. Work with two screens at the same time 
View rooms and View lecturers windows can be called and after that we can still work on the main screen 

(while these views are still open). Interaction between main screen and view screens is implemented so 

when the work is changed on the main screen it is also changed on one or both opened view screens. 
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10. Show courses without complete definition 
 

 

On »Not Allocated« screen (Analysis  Find Unallocated Turns), thereis checkbox »Show courses without 

complete definition« - in order to shorten list of unallocated schedules when course do not have complete 

definition (e.g. no lecturers defined or no groups) – so they cannot be generated anyway. 
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11. Easier moving trouhg weeks 
 

In order to move easier trough weeks we added arrows on the left and right side of week duration on 

»Occupancy« screen. Occupancy screen is called from menu Analysis  View occupancy, but also used 

when inserting schedules directly from course definition/edit screen. 

 

 

12. Colors introduced to Occupancy screen 
 

 

On Occupancy screen, to distinguish different entities (from the legend at the bottom), we introduced 

colors. By default “LA” (Lecturer allocated) fields in the table are colored red and they are bold (only text) 

but if you make left click with a mouse to any other entry at the bottom (legend), you will see that clicked 

entry now will be colored red in the table. With that we can easy and quickly see when only lecturer is 

occupied or only room, etc. 
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13. Filter for the courses 
 

There is new filter for the courses (Edit  Courses). With this filter user can filter all the displayed courses 

by entering certain character bellow “FILTER” button.  

 

 

Character that user is entering is “FILTER AID” which is defined inside the course. Filter Aid can contain any 

ANSI character. With this system we can distinguish courses into categories (e.g. »w« for winter semester, 

»s« for summer semester, »a« for all year courses, etc...) and then list only certain categories in course 

selection screen. 

 

 

 

14. Do not generate this course 
 

“Do not generate this course” option can be found at the course screen and if checked it allows user not to 

generate this particular course (even if it belongs to program7year set to generation). 
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15. Sort/Sort all options 
Option can be found in the menu Edit  Courses, Edit  Rooms, Edit  Programs and Settings  Course 

Types. In Course Types besides Sort option there is Up and Down option, options are very useful if we use 

sequential generating which takes into account course type sequence. With this options courses and 

rooms can be sorted alphabetically. Once when this is done it stays even when software is restarted – and 

such is saved into sml file or database. 

 

 

 



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 20 
 

 

 

 

16. Maximum weekly hours  
 

Now is possible to set maximum weekly hours for lecturers and for students separately. You can set 

weekly hours at the menu Settings  Miscellaneous  Generation. 

 

 

 

 



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 21 
 

17. Points system 
 

 

Points system is available at Edit  Programs and Edit  Subject Areas. Option is used to determine how 

many points is needed to pass the subject area. If points system is used in subject areas and programs, 

than relevant number of points is number of points in subject areas. If number of points in subject areas is 

0, than relevant number of points is in programs. To be able to use points system You need to enable 

Course points option in Settings → Miscellaneous → General by checking Use points system. 

 

18. Message window 
 

18.1. Message when modular courses are exceeded 

 

When modular courses hours are exceeded, system ask user if excess hours should be deleted 

automatically. 

 

 

 

18.2. Error message 
 

Error messages are improved when turn is having too many already defined hours in timetable. 
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19. New advanced options in wtt.scheme 
 

 

1. DoNotGenerateHolidays=0 – if this option is set to 1, automatic generating of schedules will not generate 

anything on holidays; 

2. ReallyDeleteHolidaySchedules=0 – if this option is set to 1, when we delete schedules with button “Delete 

schedules” at Settings  School Year Details, they are not just disabled (and colored in red) but 

completely deleted from the timetable; 

3. IgnoreNotPublishToWebForPDF=0 – if this option is set to 1, even when Course (see course editing screen) 

is not going to be published to Web, that some course will be exported to PDF file (also sent to lecturers if 

sending by email directly from application); 

4. PrintDividerForGroups=24 – this parameter is important only for printing of timetables (by groups) directly 

to printer.  It determines line spacing,  and mostly can be left alone (on 24) but on same rare prints can be 

adjusted for better timetable layout on a paper. 
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20.    IP number in the export of data into central database 
When exporting data into central database now also IP number of the current computer (when export is 

made) is written into history log and shown to users among other changes. 

 

 

21.     Disable database  
 

When history log (from database changes) is shown at the program startup, there is possibility to disable 

database completely. This is useful if making timetables for the new year (locally on PC, using only local 

xml files) and do not want to work with database at all. Other way to disable database is Settings  

Miscellaneous  General  dbsettings.ini. 

 

 

 

22.     Improvement with direct export to PowerCampus 
 

 

Direct export to PowerCampus database tables is improved by filling also event location table. Now, all 

data that is relevant for PowerCampus system is exported directly into PowerCampus database. 

Improvement with Web modules for reservation 

For the Web modules for reservation, there are new options which defines which user can reserve what 

and use which module. List of users is shown in list for login is now determined by 3-character string like 

11N – this means: must be professor, must be administrator, to be other is not important, or N10 – this 

means: to be professor is not important, must be administrator, can not be other. 
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23.     Improvement with generating  
Generating of complex multi-week timetables is generally improved.  Now generating is much quicker and 

more optimal. 
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1. Advanced timing 
 

Advanced timing option is used to determine detailed performing of the selected turn in individual 

days/weeks. In the Advanced timing box write if selected turn is performing in individual days.  See 

examples in following pictures: 

 

1.  

In this example you can declare on which days selected turn will be performed.  

0 - selected turn will not be performed on particular day 

1 - selected turn will be performed on particular day 

Note that there are always seven characters separated by comma representing each day in the week (start 

day depends on start day defined in the software, e.g. Monday, Sunday etc.). If you write less than seven 

characters, software will automatically write the missing ones. 

 

2.  

In this example you can declare on which days selected turn will be performed and in which period during 

that day. 

0 - selected turn will not be performed on particular day 

1 - selected turn will be performed on particular day 

To specify the time in particular day (we are speaking about turns that will be performed - 1 because there 

is no need to specify turns that will not be performed) use this format - 1:start hour-end hour. 

Start and end hours are defined in the software and you can easy see them in Start hour in the same 

window.  

Note: in start and end hour do not write the time, write ordinal number of the hour (also seen in Start 

hour). Example: 1:5-12 (in our case selected turn will be performed on selected day from 09:00 to 12:30) 

Same as in the first example, separate each day (seven days) by comma. 

 

Besides this manual way for Advanced timing, you can also import data via Course Constraints. The 

following data is imported: 

 course code or course name (mandatory), 

 advanced timing (can be 0 or 1. 
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Example of one CSV line: courseName;advancedTiming 

Innovation;0,1,1:5-15,1,0,1:11-14,0 or Innovation;0,1,1,1,0,0,0 

 

2. Approval system 
 

Approval system is used for making online reservations. You can set Approval system in Configuration 

pages. 

 
 
If Approval system is in use, user can make reservation, but administration needs to confirm that 
reservation. If not in use, than user’s reservation is immediately active. 
 
In case Approval system is in use, than administration needs to approve reservations. In PC application 

administration will see notification as shown: 

 

Click on notification and approve or disapprove reservation. 
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3. Active directory integration (LDUP) 
Active directory integration can be used from PC application and from web. 
 
PC application 
 
LDUP takes data from user’s active directory.  
Settings for Active directory integration (LDAP) can be found in Settings → Miscellaneous → General → 
wtt.scheme 
 
Settings are: 
  
LDAPHost=192.168.2.210 
LDAPPort=389 
LDAPLoginDN=CN=4TRESS LDAP,CN=Users,DC=wise,DC=local 
LDAPPassword=YOURPASSWORD 
LDAPSearchBase=OU=External Users,DC=wise,DC=local 
LDAPAttributeNAME=givenName 
LDAPAttributeSURNAME=sn 
LDAPAttributeDESCRIPTION=description 
LDAPAttributeEMAIL=mail 
LDAPTargetCharacterSet=WINDOWS-1250 
  
 

To use active directory integration go to Edit → Lecturers and click on LDAP. 
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If you want to see only the list of lecturer fro active directory integration mark 'Show only users imported from 
LDAP'' 
'Delete all shown' delete all shown entries. It is good to use when you make a mistake by importing users from 
LDAP, to undo the mistake mark 'Show only users imported from LDAP' and than click on 'Delete all shown'. 
 
If importing is successful you will receive notification. 
 

 
Data imported in this way are: name, surname, e-mail, notes. 
 
All users imported from LDUP will have '(LDAP)' note in Notes. 
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Web 
 
In configuration page set 'Use active directory' in use. 
 
Web pages code will not be taken, system will go directly to active directory codes. 
 

 
 
If 'Use active directory' is in use than 'AD server', 'LoginDN' and 'SearchBase' fields must be filled in. 

 
For enabling LDAP functions on web applications you need to enable it in PHP server too - change 
‘extension extension=php_ldap.dll’ in ‘php.ini’. 
You also need to copy dll files from php directory in c:\windows\system (Note: not system32!). Those files 
are: 

 libeay32.dll 

 libsasl.dll 

 ssleay32.dll. 
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4. Export to PowerCampus 
 

Data can be easily exported to PowerCampus. 
 
Settings for PowerCampus export can be found in Settings → Miscellaneous → General → dbsettings.ini 
 
Settings are: 
  
powercampus] 
powercampus_db_conn_str = powercampus 
powercampus_table = PC_COURSES 
powercampus_event_type = COURSE 
powercampus_academic_year = 2015 
powercampus_academic_term = SPRING 
powercampus_academic_session = MAIN 
powercampus_opid = ARWA 
powercampus_last_digits_for_section = 1 
 
To send data to Power Campus go to Data → Export to PowerCampus. 
 
Note that every time new version of data is sent, software delete the old one. 
 

5. Points system 
 
Points system is used for courses, subject areas, programs, students and groups. To be able use points 
system You need to enable Course points option in Settings → Miscellaneous → General by checking Use 
points system. 
 
Method of use: 
 
Courses 
 
You can decide how much points every course have by using Course points. Open specific subject and 
write in Course points number of points for that subject. 
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Subject areas 
 
Points option is used to determine how many points is needed to pass the subject are. If points system is 
used in subject areas too, than relevant number of points is number of points in subject areas. If number 
of points in subject areas is 0, than relevant number of points is in programs. 
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Programs 
 
Points option is used to determine how many points is needed to pass the program. If points system is 
used in subject areas too, than relevant number of points is number of points in subject areas. If number 
of points in subject areas is 0, than relevant number of points is in programs. 
 

 
 
Groups  
When points system is in use in groups obligations you can see number of points for a specific group - 
program automatically calculate to which courses group belongs to and sum all points. If number of points 
is enough, than texst that shows points is green, if not the test is red. If points system is not in use, than 
text is dimmed. 
 

 
 
Students 
If point system is in use than students names that don't have enough points are written in red color. 
Program finds to which groups does a student belongs to and sum all points. 
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Chapter 3 
Changes between versions 5.0 and 5.80 
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1. About screen info 
About screen information is expanded in the way that serial number of USB security dongle is displayed, 

along with used Windows version – as can be seen here: 

 
 

2. Double click selection 
 

We expanded ‘Double click selection’ functionalities, and now, option is set on the most of the tables 

including groups selections, move turn parts selection, etc. 

3. Screen size options 
 

By adding new options and buttons we tried to keep same user interface logic and not to change user 

experience too much. We optimized screen size so it fits most of laptop screens. 

4. Showing more information at the main screen 
 

With today's big monitors, we might want to show a lot of information in occupied terms already at the 

main screen. We expanded the option for that at the Settings  Miscellaneous: at the top of screen, we 

now have the following options to choose from: 

 None; 

 Groups; 

 Comments 

 Groups + Comments; 

 All data – groups, course, … 

 All data – no groups (sometimes there are so many groups or individual students, we do not want 

them to show on the main screen). 
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To turn off detailed information when printing go to Miscellaneous  General  wtt.scheme and turn 
option TurnOffDetailedCourseInfo=0 into TurnOffDetailedCourseInfo=1. 

 

Now, with the all data displayed, even without zooming in, we have the following info displayed: 
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5. Plan final exam 

5.1. Select final exam rooms 

To select the room in which the final exam will be held, on the main menu click on ‘Edit’ and select 

‘Rooms’ after which the list with classrooms at your Faculty will appear. With double click on the room 

new window where you can edit room and make the room as final exam room will open. 
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Once you selected a room, it is necessary to check whether the room has defined seats, rows and columns 

because later on module needs this information to schedule students in the final exam rooms. If 

mentioned things are not defined, you should define them by entering number of seats, rows and columns 

in boxes which are placed on the left side of the window, as you can see in the picture bellow. 

 

 

 

After the numbers of seats, rows and columns are defined, is necessary to mark box next to 'Final Exam 

Hall' and selected room will become room for final exam, as shown in the picture below. 
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After checking ‘Final exam hall’ box you need to click on ‘Confirm’ button to confirm changes. 

 

Room that is now final exam room next to the name of the room has new label “E m*n” where ‘E’ stands 

for exam, ‘m’ stands for the number of columns and ‘n’ stands for the number of rows.  

 

If you just want to see the list of final exam rooms, you can simply make it by checking 'Show only final 

exam halls' box, as shown in the picture below. 
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5.2. Select courses for the final exam 

For selecting final exam courses in the main menu open ‘Edit’ and select ‘Courses’ and you will see courses 

list. If you want to access to courses list much quicker use ‘F3’ key on your keyboard. With double click on 

the course new window with course details will appear.  

 

New window has part for final exam editing which is divided into two parts. In both parts you can see 

supervisor’s name (professor/tutor) for selected course. By clicking on the supervisor’s name new list with 

all professors/tutors for that subject will appear so you can choose who will be supervisor on the final 

exam.  
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First part for final exam editing 'Optional settings for final exam – Course Parts' is used when course part 

(lecture/tutorial) needs final exam and by checking ‘Need final exam’ course part will be scheduled for 

final exam. If that course part is major, then by clicking on ‘Course part is major’ you are giving that 

function to the course part.  
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In second part 'Optional settings for final exam – Whole Course' you are checking' Need final exam’ when 

whole course needs final exam. If selected course is major you should also check ‘Course is major’. In the 

same time you can schedule whole course and course part for final exam, and none, one or both of them 

can be major. 

When you are done with changing, confirm changes by clicking on ‘Confirm’. 

 

 

Final exam courses now besides their name have new label ‘EP’. When final exam course/course part is 

major than beside name and ‘EP’ has one more label ‘M’ which stands there for major.  
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By checking 'Show only final exam courses' or 'Show only major courses' just courses that have final exams 

or they are major will show up. 

 

5.3. Imports for final exam 
 

Imports for final exam can be done for students and for courses separately. 

5.3.1. Imports for courses 

In case that more courses needs final exam, than instead entering needed information one by one, you 

can automatically import needed data from your PC (csv/excel) by clicking ‘Import Final Exam Data’ and 

then you can see new window where you choose which data/files from your PC you will import. 
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This is example of the import: 

BIOL 101 (LCTR);BIOL 102 (LCTR);BIOL 102 (LCTR);BIOL 102 (LCTR);BIOL 102 (LCTR);BIOL 102 (LCTR);BIOL 

102 (LCTR);P201303999;; 

BIOL 101 (LCTR);BIOL 102 (LCTR);BIOL 102 (LCTR);BIOL 102 (LCTR);BIOL 102 (LCTR);BIOL 102 (LCTR);BIOL 

102 (LCTR);BIOL 112 (LAB);BIOL 112 (LAB);BIOL 112 (LAB);BIOL 112 (LAB);BIOL 112 (LAB);BIOL 112 

(LAB);BIOL 112 (LAB);P201306634;; 

BIOL 112 (LAB);P000000001;; 

CLTEST (LCTR);cltest (LCTR);P201400346;; 

ENGL 001 (TUTR);ENGL 001 (TUTR);ENGL 001 (TUTR);ENGL 001 (TUTR);ENGL 101 (LCTR);ENGL 101 

(LCTR);P201304014;; 

ENGL 101 (LCTR);ENGL 101 (LCTR);PHIL 101 (LCTR);P201304002;; 

Here we see that each line represents one student and a list of all courses where he is going to have final 

exam. Each separate list part is: COURSE NAME (COURSE PART). You can commit the course part and write 

only course name here (without parentees) and it will mean the whole course will be taken for final exam. 

Course part can be complete course type name or course type code. At the end of line is Tutor code which 

musts exists if this import is used. Note that if tutor code begins with character 'P' – it is ignored and 
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cutted-off the code. This is because some external applications generates this 'P' character in front of the 

code. 

5.3.2. Imports for students 

 

To import students automatically from your PC open Edit  Students  Import after which you will see 

new window for selecting file you want to import. 

 

Import example: 

201300116;2014;Ann;Jhonson;S-Ann.Jhonson@university.edu.eg;CHEM 101 (LCTR);CHEM 101 

(TUTR);CHEM 111 (LAB);ENGL 99 (TUTR);ENGR 100 (LCTR);MATH 101 (LCTR);MATH 101 (TUTR);PHYS 101 

(LCTR);PHYS 101 (TUTR);PHYS 111 (LAB);CSCI 101 (LCTR);CSCI 101 (TUTR);MATH 201 (LCTR);MATH 201 

(TUTR);PHYS 201 (LCTR);PHYS 201 (TUTR);PHYS 211 (LAB);SCI/ENGR 200 (SEM);SPC 201 (LCTR);SPC 201 

(TUTR);SPC 208 (LCTR);SPC 208 (TUTR);BIOL 101 (LCTR);BIOL 101 (TUTR);BIOL 111 (LAB);CHEM 102 

(LCTR);CHEM 102 (TUTR);CHEM 112 (LAB);ENGL 001 (TUTR);ENGL 101 (TUTR);ENGR 101 (SEM);MATH 102 

(LCTR);MATH 102 (TUTR);PHYS 102 (LCTR);PHYS 102 (TUTR);PHYS 112 (LAB);BIOL 102 (LCTR);BIOL 102 

(TUTR);BIOL 102 (TUTR);BIOL 112 (LAB);BIOL 112 (LAB);ENGL 101 (LCTR);ENGL 101 (LCTR) 

201300126;2014;Mark;Aniston;S-Aniston.Mark@university.edu.eg;BIOL 101 (LCTR);BIOL 101 (TUTR);BIOL 

111 (LAB);CHEM 101 (LCTR);CHEM 101 (TUTR);CHEM 111 (LAB);ENGL 100 (TUTR);ENGR 100 (LCTR);MATH 
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101 (LCTR);MATH 101 (TUTR);PHYS 101 (LCTR);PHYS 101 (TUTR);PHYS 111 (LAB);CSCI 101 (LCTR);CSCI 101 

(TUTR);MATH 201 (LCTR);MATH 201 (TUTR);NANENG 221 (LCTR);NANENG 221 (TUTR);PHYS 201 

(LCTR);PHYS 201 (TUTR);PHYS 211 (LAB);SCH 201 (LCTR);SCI/ENGR 200 (SEM);CHEM 102 (LCTR);CHEM 102 

(TUTR);CHEM 102 (TUTR);CHEM 112 (LAB);CHEM 112 (LAB);ENGL 101 (TUTR);ENGL 101 (TUTR);ENGR 101 

(SEM);MATH 102 (LCTR);MATH 102 (TUTR);MATH 102 (TUTR);PHIL 101 (LCTR);PHYS 102 (LCTR);PHYS 102 

(TUTR);PHYS 102 (TUTR);PHYS 112 (LAB);PHYS 112 (LAB);BIOL 102 (LCTR);BIOL 102 (TUTR);BIOL 112 (LAB) 

201300129;2014;Linda;Morus;S-Morus.Linda@university.edu.eg;BIOL 101 (LCTR);BIOL 101 (TUTR);BIOL 

101 (TUTR);BIOL 111 (LAB);BIOL 111 (LAB);CHEM 101 (LCTR);CHEM 101 (TUTR);CHEM 101 (TUTR);CHEM 

111 (LAB);CHEM 111 (LAB);ENGL 100 (TUTR);ENGL 100 (TUTR);ENGR 100 (LCTR);MATH 101 (LCTR);MATH 

101 (TUTR);MATH 101 (TUTR);PHYS 101 (LCTR);PHYS 101 (TUTR);PHYS 101 (TUTR);PHYS 111 (LAB);PHYS 

111 (LAB);CHEM 102 (LCTR);CHEM 102 (TUTR);CHEM 112 (LAB);ENGL 101 (TUTR);ENGR 101 (SEM);MATH 

102 (LCTR);MATH 102 (TUTR);PHIL 101 (LCTR);PHYS 102 (LCTR);PHYS 102 (TUTR);PHYS 112 (LAB);BIOL 102 

(LCTR);BIOL 102 (TUTR);BIOL 112 (LAB) 

Here we see that line begins with student ID, followed by year – this year is actually ignored by Wise 

Timetable if it is actal year like in this example. If it is school year from 1-9 it is not ignored. This data is 

followed by student surname and name and then email (used to automatically email final exam data to all 

participating students). After this basic student data, all the courses and their course parts are listed – 

those which are important for final exams, of course. 

All this information can be set manually, using Wise Timetable graphical user interface (as described in 

other help sections) but, since final exam data can be very large, we provided these two imports to make 

final exam data input easier. 

5.4. Schedule final exams 

5.4.1. Dates  

 

At the main menu select ‘Tools’ and open ‘Plan final exams’ where you can edit details about final exams. 

In part 'Dates’ in ‘Add date’ box can add final exam date/dates. After writing the date click on ‘Add’ and 

entered date will show up ‘Exam dates’. When you want to enter more dates do the same again. 
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If added date needs to be deleted, than mark the date you want to delete and then click on 'Delete'. 

 

 

 

To add the time for final exam first mark the date in which you want to enter the time and then in box 

‘Add hour’ write start time of final, click on ‘Add’ and then start time of exam will show up in ‘Starting 

hour’. In one date it is possible to add more hours. 
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If starting hours you added in one date can apply to another, than simply copy them with two steps: click 

on the date you want to copy time and then click ‘Copy’. 

Deleting hour is same as deleting date, click on time you want to delete and then click on 'Delete' 

5.4.2. Constraints – students 

 

'Settings – students' part is used to decide how many final exams and major exam students can have per 

day.  

 

 

5.4.3. Constraints – distribution  

 

'Settings – distribution' part is used to schedule students during final exams in classrooms. In this part 

there are three options and in the same time more than one option can be checked. 

Options are: 

1. 'All halls/days/hours' – by checking this option students will be scheduled in all rooms, does not 

matter which date or start hour; 

2. ‘First fill biggest hall’ - function of this option is to schedule students from bigger to smaller rooms;  

3. ‘Try also diagonal neighbors’ This option will schedule students that have same final exam in 

diagonal way. Notice: even when this option is checked software will first try to schedule students 

that have same exam not to seat near each other, but if this is not possible (because of students 

and courses structure), than students will be scheduled in diagonal way, so in any case students 

with the same final exam will not sit near/next to each other. We recommend that this option is 

always checked. 
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5.4.4. Generate exam schedule 

 

Before you save or generate final exams it's needed to give the name of the project. You can do it in 

'Project prefix' box’. The meaning of giving the name of the current project is not to mix projects that you 

are/were doing in the software. 

 

 
 

After giving a name to the project, next step is to generate changes, and that is possible by clicking on 

‘Generate exams schedule’ after which a new window will be opened. In the new window you choose 

where to save final exams data (Note: New project shouldn’t be saved in Program Files). 

 

 
 

When generating is finished in the blank part of window new table will show up. Table is made of 6 

columns. In the first column you can see final exam courses names. Second column contain number of 
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students for each course. In third column there are names of rooms in which final exams will be held. 

Dates and time for each exam are in forth column, and in fifth there are names of supervisors for each 

exam. In sixth column you can see information if course is major or not, if in that column is ‘M’ than 

course/course part that is in same row as ‘M’ is major, if the place is empty, than course/course part is not 

major.  

Above the table is its name which contains information about where the table/project is saved, name of 

the project and file format, as you can see in the next picture.  

 

 
 

5.4.5. Load exams 

With this option you can load final exam projects you made before. To do so firstly in ‘Project prefix’ box 

write the name of the project you want to load and then click on ‘Load settings/change project’ and new 

window which contains Excel files from that project will show up. In excel files there are schedules for 

each room, professor and student. The name of each file starts with the name of project. 
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1.  

Label '_c_' u in the name of the document means that document contains whole schedule ( all courses, 

rooms, professors and students); 

2.  

Label '_p_' in the name of the document means that document contains schedule for the professor whose 

name is written after the label;  

3.  

Label '_r_' in the name of the document means that document contains schedule for room. The name of 

the room is written after the label. Besides information about room, in the name of document with this 

label you can see date and time of final exam which will be held in that room; 

4.  

Label '_s_' in the name of the document means that document contains schedule for a student whose 

name is written right after the label.  
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5.4.6. Save exams 

 

To save final exams click on ‘Reset project/save exams’ by which new window will open. In the window 

you can see same documents explained in the part above. Click on ‘Done’ and Final exams will be saved. If 

you have made some changes related to final exams by saving application will save those changes, which 

means that what was generated before does not apply now. 

 

As said, ‘Reset project/save exams’ button besides saving will delete/overwrite previous documents which 

have same prefix (the name) of project and will change them with new ones. The reason for this extra 

functionality of save button is, for example, by changing date, tame etc. which are in the same project, the 

old documents don’t have the meaning like they had before, so program is deleting them. 

 

 
 

After clicking ‘Done’ program will ask if you want to overwrite the file and delete all the previous results 

(program will backup previous documents) 
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In case you want to return previous documents in the project just click again on generate button 

('Generate exams schedule'). 

5.4.7. Send Emails 

 

Choosing option ‘Send emails’ you can simply send schedules to students and professors and each will 

receive his/her own schedule. In the window you can see names of all professors and students who have 

their e-mail adress written in the applicaton.  

 

On the left side are names of professors and on the right side are names of students. 

Besides sending schedule, you can also send message. 

 

 
 

If you want to send e-mail to one or more professors and/or students than click on their name and they 

will be selected so e-mail only will be send to them. 
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Also, to select all professors/students click on ‘Select all’ and to deselect click on ‘Deselect all’. 
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After selecting persons you want to send schedules click on ‘Send e-mails’ after which this window will 

show up: 

 

 
 

If you click "Allow", program will send e-mails from your Outlook e-mail address to selected 

professors/students, and each student will receive his/her own schedule. In case you don't want to click 

YES every time this window appears – we recommend you to download freeware application from Wise 

Timetable installation directory (ClickYesSetup.exe), which clicks automatically YES buttons for you. When 

installed, it will be available in the toolbar anytime you want to turn it on/off - only by double clicking on 

this icon, as shown further: 

 
 

Besides sending schedule direct from the program, you can send e-mail from your e-mail and as 

attachment just choose document from directory in which you have saved final exam project. 

5.4.8. Add proctor 

If there is a need that some or all final exams have more supervisors, than you can choose them by clicking 

on ‘Proctors’ and new window will show up. Click on the date and time of that exam (second column) and 

in third column name of supervisor for that exam will show up. After that click on ‘Select new proctor’ and 

you will see list of all professors available for that time and than click on the name of professor.  
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After you see the name of proctor in ‘Select new proctor’ add him/her by clicking on ‘Add proctor’. If some 

proctor you added needs to be deleted, than mark the name of proctor and click on ‘Delete proctor’. 

 
 
 

Besides this you can make one proctor as chief proctor. For this mark the name of proctor and then click 

on ‘Chief proctor’ and then you should see a star (‘*’) next to the name of that proctor.  

 

 
 

After changes are made, confirm them. 
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5.4.9. Search (Individual schedules) 

 

In this part you can see box for search filter, options ‘Hall’, ‘Professor’, ‘Student’ and ‘Courses’. 

 

In search filter write words/numbers of searching object (name or student ID). In the same time as you are 

writing if that kind of information is in the program, than one or more options named above will become 

darker green and you will be able to see how many searched data you can find in that option. Click on that 

option and searched information will show up bellow.  

 

 
 

6. Statistic of the room utilization 
 

Often users want to see what is utilization of rooms during the school year. This information can be used 

for planning the future expansion of school facilities or to optimize distribution of courses throughout the 

rooms. 

 

This utilization is now presented on room overview screen (Analysis  View Rooms). 

 

After each room name, there is percentage, telling you what is room utilization for the period set (from 

week to week). 
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These numbers would not be very useful if you take into account all the defined time slots you have. 

Probably you do not want to calculate room utilization from 7 in the morning to 23 in the evening, taking 

into account that average room occupancy occurs during the day working hours. 

 

In order to make these numbers more "real", we introduced parameters telling the software in which day 

period the room utilization is calculated. These parameter scan be set at Settings  Miscellaneous screen 

as follows: 
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In case shown, room utilization will be calculated only for day time between 8 and 16. 

7. Change room 
 

When changing schedule on the main window (double click on room) now is possible to change the room 

in which class will be performed. Available (free) rooms at that time are colored green. To select new 

room just mark room (make one click on the room name) and confirm your changes. 
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8. Change professor 
 

When editing schedule on the main Wise Timetable window, you can also change professor.  If there is 

‘/X/’ sign in front of professor’s name, than that professor is occupied for selected terms. 
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There are two ways of changing professors – change professor only for this week and change professor for 

all weeks for this lecture. 

 

When change is made for one week, existing professor’s turn part is only “disabled” in the schedule. 

 

When change is made for all weeks, professor takes complete turn part from existing professor. 

In both cases, new turn is created for new professor, those turns might or might not be displayed in the 

course definition. You can control professor’s changes visibility at Settings  Miscellaneous  General if 

you turn on/off “Show replaced professors at course screen” button.  
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9. Detailed overviews 

9.1. Detailed info at rooms overview  
 

At Analysis  View Rooms, you get screen with all rooms occupancy overview. We introduced also 

detailed information displayed inside occupancy boxes – so you can see what is happening inside occupied 

term. This info display is optimized, according to occupancy length. Here is the example: 
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9.2. Detailed info at lecturer overview 
 

Similarly to room overview, we've put detailed info about courses also for lecturers. The content of 

information is optimized according to length of particular lecture. It looks like this: 
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10. Define a role for professors 
 

It is now also possible to attribute a title or role to lecturer: Administrator, Tutor, Professor or Other and it 

is mostly used for making web (online). 

 

This leads to easier control of who can make web reservations of a particular room. Here's how it looks in 

Room's Specifications where you can simply decide who can do reservations based on the previous giving 

of "roles" to lecturers in Lecturer's Specifications, which are displayed bellow: 

 

 
 

11. Warn when professor reach certain number of weekly hours 
 

Here you can set how many hours are "allowed" for professors. Therefore, if you set to 40, if later more 

activities and more hours than 40 are dedicated to any professor, the software will warn you about that. 

The option is located in the Generation part of Miscellaneous in Settings, as you can check in the following 

window: 



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 65 
 

 
 

12. Personal record 
 

Option is listed in the menu in Data  Export to CSV file Personal Record Report as the last option 

which is shown in this picture: 
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Personnel Record Report is very helpful option and helps us to calculate all of working hours of different 

lecturers so we can have records of how much a particular lecturer worked in a period of selected time. 

Working hours are divided according to programs and subject areas. This option is selectable in the 

following window:  

 

  
 

13. Two levels of warning regarding groups occupancy  
 

Now it is possible to make two levels of warning for groups when you putting them in course screen – 

regarding maximum allowed occupancy of groups per week. The warning will pop out when too many 

hours for the group are planned. The reason for having two levels of warnings is that some groups need 

warning before and some after certain hours. It is possible to have both warnings checked.  
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To set this option open Edit in the main menu and select Groups and in that window open Edit. 

 

 

To define warning levels open ‘Settings’ and choose ‘Miscellaneous’. In the boxes write maximum allowed 

groups occupancy for each level. 
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14. Group note at PDF template editing 
 

Sometimes group notes needs to be displayed on reports too (group notes are sometimes represented by 

student names – when each student is actually one group). This option is added at PDF template editing: 
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15. Hiding sub-groups in selection 
 

In case you have many groups and even more subgroups, where subgroups are not of particular interest 

for displaying (because it is hard to find particular group in very long list), you can hide subgroups. To do 

this check the checkbox at “Main selection parameters” sections. 
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16. Course type code 
 

At Course type screen (Settings  Course types) now you can also enter course codes – these codes are 

used at various imports – in order to make course type strings shorter or to allow two-way identifications 

– by name or by code. 



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 71 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

17. Generate until hours 
 

This option gives us much more flexibility for generating – when we actually have only a total number of 

hours and desired weekly distribution but it is not important that every week is having the same 

distribution. Only important is that software is putting the hours through the weeks (trying to fulfill the 

desired distribution specified in Duration e.g. 2+2+2) all the weeks but stops when this total number of 

hours is reached. Option is set separately for each selected turn.  
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If you leave this option at number »0« it is ignored. If you put here number of hours, it will generate the 

course part (turn) so many weeks until this number is reached. Course parts (turns) with this option 

turned-on are also handled correctly but Analysis  Find unallocated courses and by other modules – so 

even if some weeks are not distributed fully – it is important that total number of hours is reached and 

because of that the course (part) is colored with yellow color in that case. 

18. Anchor relations 
 

You can find this option at Edit  Courses Course screen. Option gives unprecedented flexibility in 

specifying time position relations between various. When anchors are set once they cannot be moved and 

if you have a lot of locked schedules, they can be on the way to courses with anchors relations. 
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There can be one or more anchor relations defined for one turn. Anchor relations are specified by »,« 

between them. Every anchor relation is heaving the following format: ANCHOR+N(d/h), but the format can 

be like this too: ANCHOR; ANCHOR here is a number, representing “virtual reference” to a course part 

(turn). Every anchor must have definition at some turn at least once. 

 

Let’s see an example: 1+2d  the anchor relation tell us the following: we are going to generate this part 

at least 2 days after course part referenced by number 1. 

 

We can put at more course parts the same anchor without any relations – for example set anchor at 

Mathematics: 45 and anchor at Physics – Math part: 45. As you can see there is no »+« or »-« sign at this 

anchor which means that this is reference or “base” anchor. In our example both courses will be 

generated at the same hour and day – thus making intentionally overlapping, if you like so. Base anchors 

are first tried to be set somewhere in the middle of the week and middle of the day because there is the 

best probability that anchor relations will work. 

 

But if we put at Physics – Math part the following relation; 45-3h that means that Physics – Math part will 

be generated at least three hours before Mathematics. 

 



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 74 
 

Note that we can combine anchor relations and generate certain part before some parts and after some 

parts, etc. there are endless options for these anchors – making generating exactly as we want it to be. 

 

If you want that anchors with hour relations are on the same day go to Miscellaneous  Generation and 

check ‘Anchors with hour relation are on same day’. 

 

19. Generate only this course 
 

 

Another new automatic option is Generate only this course - in the next generating only this course will be 

generated and after generating this option will be unchecked.  

 

 
 

Also, if you set in the Miscellaneous (Settings) that Saturdays and Sundays are not generated, this course 

will be unable to generate on those days - as it is seen in the next picture. This option overrides the 

settings you make on check boxes for selecting days. 
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20. Force free day after 
 

This useful new option called Force free day after - is used if a course whose lectures or other activity is 

scheduled for today and the next day is needed to be free of that course (free day after) if for example 

students have difficult homework so they need more time to do it, or professor is unable to come day 

after because he has lectures of that course in some other location that next day, etc. 
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21. Filter not allocated courses 
 

To see not allocated course open ‘Analysis’ in the main menu and select ‘Unallocated Turns’. When 

showing not allocated courses there might be a lot of courses which are not even intended to be allocated 

yet, and to filter-out those courses check ‘Show courses without complete definition’ box. 
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22. Handling of modular courses 
 

To set course as modular open Edit  Courses and open wished course with double click. In the top right 

corner of the screen, in ‘Course Style’ part, you can see radio buttons Periodic/Modular. 

 

 
 
 

Things that distinguish modular and periodic courses are: 

 Modular courses are never generated; they are reserved for manual inserting; 

 For modular courses we do not enter weekly duration field (because it is not periodic – it is 

modular- not repeating). We enter only total number of hours over the period of weeks defined on 

screen shown above; 

 By not entering weekly hours but only total number of hours you are given freedom to distribute 

these hours more freely across the defined period; 

 When press on »>Schedule« button, you can distribute these total hours among the weeks, and 

you’ll get this screen: 
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You will notice that (unlike for Periodic courses), there is additional field »Hours«, with default of 4 hours: 

this means when you insert this course hours into calendar, only 4 hours will be inserted. For Modular 

courses only one week is displayed at once (by default first of defined weeks) and whatever weeks you 

choose there, the inserted hours will be valid always for one week – defined in »From« field.  

 

So you can change »Hours« field to any number of hours and all course terms will be fulfilled (and course 

on previous screen will be colored yellow) when sum of all inserted hours is equal to »Total« hours you 

entered for Modular course. Of course, you can insert these hours for Modular courses also from the Main 

screen (right click on empty slot and pick »New« from the context menu). 

 

With this method, we can distribute hours freely throughout the defined weekly period. 
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23. Mandatory breaks for students 
 

 

This is the option for setting automatic breaks for students differently from that well known way to set 

blocks in every room at the same time, every working day in a week. For example, if a lot of students are 

attending a university, than it would be very crowded if all students had a break at the same time. 

Therefore, this option is very helpful because it sets automatic breaks for all groups but only after they 

attended 4 hours block of activities at university. Therefore, the space will not be crowded, and every 

group will have a deserved break of 1 hour after 4 (or other number of hours that can be set here) of 

activities are finished. These breaks for each group will be presented in a schedule as empty fields. This 

option is located in a Generation part of Miscellaneous, as it can be seen on the following picture:  

 

 
 
 

Also, it is important to note that there is a setting in every group’s specifications (Edit  Groups  certain 

group), there is a checkbox to Ignore mandatory breaks for a certain group for special reasons. For 

example it could happen if a group doesn't need a break after 4 hours, or if there is a special guest 
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professor that will be there only one day, so students have no breaks at all, etc. There is also set how many 

hours are needed to pass for that single group to have a mandatory break. Here it is how it looks in a one 

group's specification: 

 
 

24. Import data from CSV file 
 

 

Besides rooms, lecturers, courses and students import from CSV file, now you can import reservation, 

exams, course constraints, courses – misc, groups – misc and student misc. 

You can see examples of all data import from CSV at www.wisetimetable.com  Usage  Data Entry. 

To import data from CSV file go to Data  Import Data From CSV File and select data which you want to 

import. 

http://www.wisetimetable.com/
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24.1. Import reservations 
 

 

When importing reservations the following data is imported: 

 Date (mandatory, must be in date format defined Settings  Miscellaneous  View, e.g. 25.3), 

 Duration parameters in following format: first hour:first minutes - second hour:second minutes, 

e.g. 08:30-10:00. Note that, in order that this import is successful, your time labels (set in Settings 

Time labels) must conform to this format in order to find appropriate hours, 

 Room name (mandatory) 

 

Data example: 

Date Duration parameters Room name 

13.4 10:00-12:00 R 1 

14.4 10:00-12:00 R 3 

 

Example of one CSV line:  

date;durationParameters;roomName 

13.4;10.00-12:00;R1 
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24.2. Import exams 
 

 
When importing exams the following data is imported: 

 Date (mandatory, must be in date format defined Settings ➝ Miscellaneous ➝ View, e.g. 25.3), 

 Start hour in format HH:MM (mandatory), 

 End hour in format HH:MM (mandatory) - Note that, in order that this import is successful, your 

time labels (set in Settings ➝ Time labels) must conform to this format in order to find appropriate 

hours. 

 Course name (mandatory), 

 Room name (mandatory), 

 Professor 1 name (mandatory), 

 Professor 2 name (mandatory, can be empty), 

 Professor 3 name (mandatory, can be empty), 

 Professor 4 name (mandatory, can be empty), 

This import will make room reservations with comments including course and professor's name. 

Data example: 

Date Start 

hour 

End hour Course 

name 

Room 

name 

Professor 

1 name 

Professor 

2 name  

Professor 

3 name 

Professor 

4 name 

25.4 10:00 12:00 Databases R 1 Tom 

Rogers 

   

25.4 13:00 15:30 Financial 

Accounting 

R 4 Exam Margaret 

Wood 

  

26.4 11:30 14:00 Innovation R 2 Midterm 

Exam 

Stan 

Philips 

  

 
Example of one CSV line:  
 
date;startHour;endHour;courseName;roomName;professor1name;professor2name;professor3name;prof
essor4ame 
 
25.4;10:00;12:00;Databases;R1;TomRogers;;; 
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24.3. Import Course Constraints 
 

 

This import is modified so you can import two different kinds of data. 
 
1. The following data is imported: 
- course code or course name (mandatory), 
- generate for sixth day of the week (mandatory, e.g. Saturday, can be 0 or 1), 
- start hour (mandatory: if you put -2 into this value, start hour and following parameters will be ignored, 

otherwise this corresponds to time label sequence number), 
- after hour (mandatory, can be 0, -1, 1. 0=start hour is exact hour of course start, -1=course will start 

before start hour, 1=course will start after start hour). 
 
2. The following data is imported: 
- course code or course name (mandatory), 
- advanced timing (can be 0 or 1). Advanced timing is explained in Edit Fields section. 
 
 
Data for one course constraint are written in one row. Example of one CSV line:  
 
1. courseName;generateForSixthdayoftheWeek;startHour;afterHour 
Innovation;0;-2;0 
 
2. courseName;advancedTiming 
Innovation;0,1,1:5-15,1,0,1:11-14,0 or Innovation;0,1,1,1,0,0,0 
 
Note: In one import you can use both kinds of data. 
Innovation;0;-2;0 

24.4. Import courses - misc 

 

This is comprehensive and very intelligent import which has certain flexibility, regarding input file format. 

Settings for this import (similarly to other two miscellaneous imports – for groups and for students) can be 

popped-out by clicking on file name import_courses_misc.ini at Settings  Miscellaneous  General 

screen: 
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This file contains description, where are the various fields inside the import file. So with filling-in this ini 

file, we can say that course name is in column 5 of the import file or any other. This will give us great 

flexibility, regarding the import. We can even set delimiters of the input file, set course constraints, etc. 

This import is completely aware of the existing state in timetable – only entities which are not found 

(programs, branches, years, courses, constraints …) are created. There is no worries if the same or 

modified file is imported more times into same timetable. 

Ini (Settings) file for the import looks like this (telling us at which columns is information): 

// Menu->Import from CSV->Import courses misc: configuration,  

// is comment line, USE ANSI ENCODING PLEASE 
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17; NUMBER OF COLUMNS 

,; DELIMITER BETWEEN LINE COLUMNS 

-; PLACEHOLDER FOR EMPTY OR NON-RELEVANT COLUMNS 

1; program name 

2; year 1-9 

3; first week 1-52 

4; last week 1-52 

5; fixed term in form: N:TIME LABEL, where N is number of work day in week (1-7), TIME LABEL must exists 

already! 

6; course name 

7; course type  

8; first tutor last name 

9; first tutor first name 

10; second tutor last name (can be empty) 

11; second tutor first name (can be empty) 

12; third tutor last name (can be empty) 

13; third tutor first name (can be empty) 

14; duration in one week (duration string: e.g. 4, or 2+2) - will be applied for each week from first to last 

15; preferred room name (can be empty) 

16; number of students in one turn - if this is exceeded, new one will be automatically created 

17; skip pauses (0 or 1) - assume there is no pauses between hours - use mapping from files 

wtt.fromschmap and wtt.toschmap 

There are descriptions inside the file about the rows. Imported file itself looks like this: 

// first line – is ignored! 

OTO,2,22,37,,Marketing,P+S,Tom,Brig,,,,,3,,125,1 

OTO,2,22,37,,Marketing,V,Sting,Nina,,,,,2,L4,15,1 

GMT,1,22,37,,Mathematics,P+S,White,Ann,,,,,4,,125,1 

GMT,1,22,37,,Mathematics,V,Shon,Lowren,Weingerl,,,2,RU-2,15,1 

PTO,1,22,37,, Mathematics,P,Byork,Barbara,,,,,2,,125,1 

… 

 

When importing courses – misc the following data is imported: 
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 Program name (mandatory), 

 Year (mandatory), 

 First week (mandatory), 

 Last week (mandatory), 

 Course name (mandatory), 

 Course type (mandatory), 

 First tutor last name (mandatory), 

 First tutor first name (mandatory), 

 Second tutor last name (can be empty) 

 Second tutor first name (can be empty) 

 Third tutor last name (can be empty) 

 Third tutor first name (can be empty) 

 Duration in one week (mandatory), 

 Preferred room name (can be empty) 

 Number of students in one turn (optional), 

 Skip pauses (0 or 1) (optional). 

 

Data Example: 
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Find an example of a CSV file on www.wisetimetable.com  (DATA IMPORT). Example of one CSV line:  

http://www.wisetimetable.com/
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programname;year;firstweek;lastweek;coursename;coursetype;firsttutorlastname;firsttutorfirstname;sec

ondtutorlastname;secondtutorfirstname;thirdtutorlastname;thirdtutorfirstname;durationintheweek;prefe

rredroomname;numberofseats;skippauses 

 

Undergraduate;1;1;21;Databases;tutorial;McClusky;James;Meyers;Nicole;;;2;R1;5;1 

 

24.5. Import groups – misc 
 

 

Similarly to courses, you can import groups in the same, very flexible way. Ini (Settings) file for the import 

is accessible from the Settings  Miscellaneous  General screen. Additionally to column positions, you 

are able to set certain ignore rules and dictionary. 

Settings file looks like this: 

// Menu->Import from CSV->Import students misc: configuration,  

// is comment line, USE ANSI ENCODING PLEASE 

6; number of all columns in one line 

,; delimiter between the columns 

-; placeholder for empty or non-relevant columns 

1; group name - will become group containing number of students in next field 

2; number of students in a group 

3; program of the group (same as branch/subject area) 

4; year number 1-9 

5; course name 

6; alternative course name 

"Diploma","Statistics in macroeconomics"," Statistics in microeconomics " ; all the courses which will be 

ignored during the import 

// next line is a small dictionary for program names - program name will be mapped into word in 

parenthees "short name". Use one or more lines 

school program (level 1) Graphic communication,"GIK" 

professional study program (level 1) Graphics and Media Technologies, "GMT"Courses dictionary: 

Finishing graphic products, "finishing graphic products - graphic finishing" 
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Graphic finishing, "finishing graphic products - graphic finishing" 

Graphic investigation, "Graphic investigations - Investigations in the graphic" 

Ignore list is in the line immediately after alternative course name line. Courses listed here are ignored 

when encountered in import file. 

After ignore line, there is a dictionary you can use to map long names into short program names. 

After this dictionary, there is mandatory line named »Courses dictionary:«, which announces the last part 

of settings file, which is courses dictionary – used for mapping of course names as shown in import file into 

real names existing in timetable. 

Please use parenthees in the same way as it is in presented example.  

Note that groups are distributed nicely across all the course parts – so there are equal number of groups 

for the professors having same course, etc… 

Branches will be created with the same name as program name. 

Example of actual import file is here: 

// first line – is ignored! 

Group1,24,GroupProgram,2,English,English Literature 

Group2,16,GroupProgram,1,Math,Algebra 

… 

When importing groups – misc the following data is imported: 

 Group name (mandatory), 

 Number of students in s group (mandatory), 

 Program of the group (mandatory), 

 Year number (mandatory), 

 Course name (mandatory), 

 Alternative course name (optional). 

Data example:  
 

Group name Number of 
students in 
group 

Program of the 
group 

Year number Course name Alternative 
course name 

Group 1 10 Undergraduate 1 Databases  

 
 
Example of one CSV line:  
 
groupName;numberOfStudentsInGroup;programOfTheGroup;yearNumber;courseName;alternativeCourseName; 
 
Group1;10;Undergraduate;1;Databases; 
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24.6. Import students – misc 
 

 

This import is intended for organizations wanting to map each student into separate group. Result of this 

import will be a number of groups having number of students 1. So each group is one student and group is 

named by student ID. With this (provided you have a lot of professors and rooms), you can have very 

individual timetables for each of your students. 

Ini (settings) file for this comprehensive import is accessible in Settings->Miscellaneous->General – and is 

called import_students_misc.ini. It looks like this: 

// Menu->Import from CSV->Import students misc: configuration, 

 // is comment line, USE ANSI ENCODING PLEASE 

10; number of all columns in one line 

,; delimiter between the columns 

-; placeholder for empty or non-relevant columns 

66; Percentage of students over the top of current turnus in order to divide turnus into two parts 

1; student last name 

2; student first name 

3; student ID - will become group containing only one student - with this name 

4; program of the student (same as branch/subject area) 

5; year number 1-9 

8; course name 

9; alternative course name 

"Diploma", "Practical Lessons", "Practical Training" ; all the courses which will be ignored during the 

import 

// next line is a small dictionary for program names - program name will be mapped into word in 

parentheses "short name". Use one or more lines 

university study program (Level 1) Graphic and Interactive Communications, "GIK" 

professional study program (Level 1) Graphics and Media Technologies, "GMT" 

Courses dictionary: 

Finishing graphic products, "finishing graphic products - graphic finishing" 

Graphic finishing, "finishing graphic products - graphic finishing" 

Graphic investigation, "Graphic investigations - Investigations in the graphic" 
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As you can see, everything can be set up – along with dictionaries. These dictionaries and ignore list is 

explained in section for group importing (misc way). 

Actual import file example: 

// First line is skipped! 

Smith,Clara,32012098, professional study program (Level 1) Graphics and Media Technologies, "GMT", 

Diploma BVS,Diploma,full year 

Smith,Clara,32012098, professional study program (Level 1) Graphics and Media Technologies, "GMT", 

Diploma BVS,Diploma,summer 

… 

Here some more intelligence is involved, when creating turn parts: we use a number which is set inside 

the ini (settings) file – which is actually percentage of students which must be over the defined top 

number for »group size« in order to split the group into two groups – in this case into two turns. With this 

method we avoid having full groups of students and then also groups with only one or two students. 

Group is splitted into two groups only when it reaches »Desired number » + »Desired number« x 

Percentage/100. 

When importing students – misc the following data is imported: 

 Student surname (mandatory), 

 Student first name(mandatory), 

 Student ID (mandatory), 

 Program of the student(mandatory), 

 Year number (mandatory), 

 Course name (mandatory), 

 Alternative course name (optional). 

Data example: 

Student 

surname 

Student first 

name 

Student ID Program of 

the student 

Year 

number 

Course 

name 

Alternative 

course name 

Adams Rickena 12568 Undergraduate 1 Databases  

Example of one CSV line:  

studentSurname;studentName;studentID;programOfTheStudent;yearNumber;courseName;alternativeCou

rseName 

Adams;Rickena;12568;Undergraduate;1;Databases; 
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25. Saturday is the first working day 
 

 

First working day is Sunday - click if your organizations' stating day of the week is Sunday. After checking 

this option and confirming it, the whole schedule, presentation pages and working interface will start with 

Sunday instead of Monday as a first day. It is located in Settings  Miscellaneous  View in the very 

down-left corner of the window. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

26. Access to all configuration files directly from application 
 

 

Recently, new Windows versions changed permissions, who can write into which directory etc… To be able 

to cope with all the new security policies, we had to change configuration files position into directory 

which is reserved for Applications: c:\ProgramData – and created our subdirectory there: 

c:\ProgramData\WiseTimetable. Now, all the configuration files are there. Note that this directory does 

not exist on Windows XP (and earlier windows) systems. To keep compatibility with really all Windows 
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systems, Wise Timetable creates Configuration directory in the Wise Timetable installation directory – e.g. 

c:\Program Files (x86)\Wise Timetable\Config. 

 

There is a little problem with c:\ProgramData directory: it is initially hidden by Windows and users need to 

show hidden files in their file explorers in order to access configurations for applications. 

 

To avoid this, we've put buttons with file names at Settings  Miscellaneous  General – and by pressing 

these buttons, you can access configuration files without taking care about their actual position. 
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27. Sending data to mobile phones 
 

 

Wise Technologies made two mobile applications for displaying timetables – one for Android and one for 

iOS (Apple) mobile devices. Wise Timetable users do not have to have database or web pages established, 

in order to use these applications. It is possible to send basic timetable information directly to Wise 

Timetable servers only by ticking the option »Allow sending data for mobile applications« at Settings  

Miscellaneous  General. When this option is ticked, whenever you save to your timetable or export it 

into database, some part of timetable is sent to Wise Technologies web in order to enable information for 

mobile devices. 

 

 
 

Mobile applications are free of charge and available from app stores. 
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28. Administrative check of XML files 
 

 

At main Help menu, there is option »Check XML file«. It is really advanced option and used solely for 

resolving inconsistency problems in XML files where timetable is stored.  

 

 
 

Sometimes, users enter special characters into reservation comments, course names and similar and these 

special characters (in rare cases when not handled by the system) are not allowed in standard XML format. 

With this menu option, software will show you line numbers when inconsistencies are found – there might 

be some false negatives here. This option is used only when XML cannot be loaded because of corrupt 

data. 

 

29. Hide disabled hours  
 

 

In case you don't want to see disabled activities on the main Wise Timetable window go to Settings  

Miscellaneous  General and choose “Hide disabled hours” option, as shown in the picture bellow: 



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 95 
 

 
 

30. Web pages improvements 
 

 

There is whole line of web pages improvements: 

1. Graphical interface is improved; 

2. There is a new option for sorting the lectures by date instead of grouping them by course when 

displaying lecturer whole year schedule. With this option, only schedules from today's date are 

displayed; 
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3. In URL representing the groups (groups.php) and professors (prof.php), now you can set 

parameters already – so there is no need for any selection – timetable is displayed right away! That 

way you can bookmark this URL and call it later to display your timetable without annoying 

selections. Of course, these parameter scan be omitted and pages used without them… 

4. Reservations of rooms and groups are improved greatly. Now you can reserve more rooms at once, 

reserve more professors at once, reserve more days (or weeks) in a row, calendar of occupation of 

currently selected entities is displayed on right side when reserving groups – so you can click on 

empty space to reserve groups directly in that empty slot, now you can enter more confirmation 

email addresses separated by »;« in email field, after reservation you can stay on current screen 

with current selection and continue with similar reservations, … 

5. Room sort order is now exactly as it is in desktop application – unless you define strictly alphabetic 

sort order in web administration page (configure.php). 

 

31. Web note 
 

 

To alert about some changes or news now is possible to write note to the web for courses, proctors and 

groups. Maximum length of notifications is 512 characters. Open Edit in the menu and choose 

Courses/Proctors/Groups. 

 

31.1. Lecturer web note 
 

 

In ‘Notification for web pages’ you can insert one or more notifications important for professors. If the 

notification is same for all professors you can make faculty-wide announcement by checking ‘Copy to all 

other professors’ and all professors will be able to see the notification. 
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 When you export data to database, this notification will be visible on top of the professor’s timetable 

screen. 

 

To cancel or delete notification just delete this edit field content and confirm the screen. Notification will 

stay on the web until you delete it here. To be able to remember easily to whom you sent notifications 

and to maintain/change/delete notifications easily, next to the name of professors that currently have 

non-empty (active) notification new labels “>” and “(note exists)” will show up. 
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31.2. Groups web note 
 

 

Insert web page note in 'Notification for web pages' 

 
 

Since there might be many groups defined in the system, we made a lot of options for copying the group 

notification to other groups. Copy options are: 

 'Copy to all groups in branch'; 

 ‘Copy to all groups in program';  

 'Copy to all groups in year'; 

 'Copy to ALL other groups'. 

To be able to easily distinguish groups with and those without, groups notifications are colored differently 

(gray background). 
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To delete notification(s) just set the notification field to empty and if you like to delete also other group’s 

notification, deselect previously selected copy options bellow. 

 

31.3. Course web note 
 

 

Insert web page note in 'Notification for web pages'. To be able to write web note you need to select 

course first. Courses web note will appear only at course view web page. Notification is saved to the 

course only after pressing ‘Save course notification’ button, and saved to web pages after export to 

database. 

 

 
 

Courses that have web note also have new label in front of their name “>”. 
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You can also filter all the courses with notifications simply by pressing the checkbox »Show only courses 

with notes« 
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32. Web reservations 
 

You can make web reservation for rooms and groups. 

 

32.1. Reservations for rooms 
 

 

Users of the application can be: lecturers (professors, assistants, etc.), administrative staff, or anyone else 

with enabled access.  

Installation is very easy. It is installed the same way as other web applications for viewing timetables. Data 

is read from the same database as the applications for viewing timetables. It is made in PHP  

programming language.  

Access to application is enabled with the user name and password (user name is the name; password is set 

in the Wise Timetable desktop application).  

 

 

 

 

In overview of all rooms (on a given day), free room can be easily found as grey fields.  

 

 

Click at free time and make reservation. 
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 Room reservation - choose room you want to reserve. You can choose one ore more rooms. To reserve 

more rooms use Ctrl + click on rooms or Shift + click. 

 Date - the date when reservation is made. 

 Lecturer - you can choose one or more professors. 

 Description - you can write more details about reservation. Software automatically insert professor's 

name and room name. You can delete automatic description and write your own or continue with 

writing description) 

 Interval - interval is set automatically with the date and time on which you click to make the reservation. 

Interval can be changed. 

 Duration days - if you enter 'n' number (bigger than 1) than same reservation will be made for 'n' 

number of next days. Note that weekends are skipped. 

 Email - if professor's email is entered before in professors specification than email will be automatically 

entered, if not, you can enter email. In case more professors are chosen, email of last chosen professor 

will be seen. 

 Back - click here and reservation will be cancelled. 

 Description - click here and description field will be set back to default. 
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 Reserve - click to make reservation. If reservation is successful you will go automatically to previous 

screen and you will be able to see your reservation in blue color. If reservation is not successful, you will 

stay on the same screen where notification about error. 

 

If the user clicks on any reserved field (hour), details are displayed. In case of regular lectures, the name of 

the course, day, hour, course type, duration or time interval and lecturer are displayed. In case of room 

reservation, time interval, duration (how many hours are booked), description and lecturer are displayed.  

  

The user can delete only his own reservations, and cannot interfere in the reservations of other users 

(Note: except it is set that only main admin can make reservations in his own name and in the name of 

other professors).  

 

Changes made with the web application are saved directly in the database. User of the Wise Timetable 

desktop application can lock the database while working. This means that online reservations can still be 

made, but when exporting into database, an additional window is displayed, showing all the changes made 

through web application in the meantime.  

  

Any changes made with the web application can be verified through website for administrators. Also, 

there are additional settings in the Configuration section for Room Reservation Module Settings. 

 

32.2. Reservations for groups 
 

 

Users of the application can be: lecturers (professors, assistants, etc.), administrative staff, or anyone else 

with enabled access.  

  

Installation is very easy. It is installed the same way as other web applications for viewing timetables. Data 

is read from the same database as the applications for viewing timetables. It is made in PHP  

programming language.  

  

 

Access to application is enabled with the user name and password (user name is the name; password is set 

in the Wise Timetable desktop application).  
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In overview of all groups (on a given day), free room can be easily found as grey fields.  

 

 

 

Click at free time and make group reservation. 
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 Room reservation - choose room you want to reserve. You can choose one ore more rooms. To reserve 

more rooms use Ctrl + click on rooms or Shift + click. 

 Date - the date when reservation is made. 

 Lecturer - you can choose one or more professors. 

 Program - choose program. 

 Year - choose year. 

 Subject area - choose subject area. 

 Group - choose group you want to reserve. You can choose one ore more groups. To reserve more 

groups use Ctrl + click on rooms or Shift + click. 

 Description - you can write more details about reservation. Software automatically insert professor's 

name and room name. You can delete automatic description and write your own or continue with 

writing description) 

 Interval - interval is set automatically with the date and time on which you click to make the reservation. 

Interval can be changed. 
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 Duration days/Duration weeks - if you enter 'n' number (bigger than 1) than same reservation will be 

made for 'n' number of next days/weeks. Note that weekends are skipped. 

 Find slot - click to open reservation calendar. 'X' on time slot marks current reservation position. Click on 

any slot to change date and time of reservation, software will ask for confirmation of reservation 

change. When you confirm changes, reservation will be saved and software will return you to the 

previous window. 

 Email - if professor's email is entered before in professors specification than email will be automatically 

entered, if not, you can enter email. In case more professors are chosen, email of last chosen professor 

will be seen. 

 Back - click here and reservation will be cancelled. 

 Description - click here and description field will be set back to default. 

 Stay after reservation - check to stay on this window after confirming the changes. 

 

If the user clicks on any reserved field (hour), details are displayed. In case of regular lectures, the name of 

the course, day, hour, course type, duration or time interval and lecturer are displayed. In case of room 

reservation, time interval, duration (how many hours are booked), description and lecturer are displayed.  

  

The user can delete only his own reservations, and cannot interfere in the reservations of other users 

(Note: except it is set that only main admin can make reservations in his own name and in the name of 

other professors).  

 

Changes made with the web application are saved directly in the database. User of the Wise Timetable 

desktop application can lock the database while working. This means that online reservations can still be 

made, but when exporting into database, an additional window is displayed, showing all the changes made 

through web application in the meantime.  

  

Any changes made with the web application can be verified through website for administrators. Also, 

there are additional settings in the Configuration section for Room Reservation Module Settings. 
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33. Option ‘Delete’ does not delete turns in holidays, but disables them 
 

 

We enabled that option "Delete" really does not delete settings for school year any more but all activities 

are now only disabled and these are then shown in the schedule in the color red. So it does not break 

courses and their movement is still completely possible. You can also set on which day comes different 

holiday and those days will be accordingly colored in the schedule, individual activities on these days will 

be disabled (unless they are “Forced”) and during automatic generation activities will not be set on these 

days. 

 

34. Print all screens at once 
 

 

To print all screens at once open ‘File’ in the main menu and select ‘Print’. Program will automatically print 

all screens for currently selected view, e.g. ‘Room’. This means when you select view by ‘Room’ all the 

rooms will be printed, software will automatically select all the rooms one-by-one and send the displayed 

screen to the printer. Software will not send simple screenshot to the printer, but will actually make 

optimized print for the paper including taking care about overlapping courses, titles, legends and many 

more parameters which you can set-up at Settings  Miscellaneous  Export. 

 

 
 

35. Save as PDF 
 

 

With this option displayed entries at the main Wise Timetable window will be saved as PDF. For instance, 

if you choose view by ‘Course’, Wise Timetable will export files that you can see on the main window to 
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PDF. When you select this option program will ask you from which to which date (week) you want to 

export data and where to save new files. 

 

 
 

Result files will have prefix as follows: <prefix>_<entry name>.pdf (prefix is your input and entry name is 

name of room, or Surname+Name of professor or student, or course name, etc.). 

 

36. Save to PDF –all 
 

 

With this option all displayed entries can be exported to PDF at once. Option is similar to the ‘Print’ option 

and it is located in ‘File’ in the main menu. If you choose view by ‘Room’, Wise Timetable will export as 

many files as there are rooms. When you select this option program will ask you from which to which date 

(week) you want to export data and where to save new files. 

 

 
 

Result files will have prefix as follows: <prefix>_<entry name>.pdf (prefix is your input and entry name is 

name of room, or Surname+Name of professor or student, or course name, etc.). 
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37. School year expansion 
 

 

New mandatory information in school timetable is City and School name. This info is used also in mobile 

applications to identify organization which is owner of the timetable. New info must be entered in School 

details screen (Settings  School Year Details). 
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38. Full screen edit 
 

 

Full screen editing is enabled in menu Tools  Full screen edit and, and  it can be also accessed by F11 

key. 

 
 

39. Unified font across the user interface 
 

 

Accidently, during the development of Wise Timetable in last 12 years, there were some font mishaps in 

various screens – this was not easily seen on screens with 100% magnification of fonts. However, when 

fonts are magnified, also differences are visible more easily. Current version of Wise Timetable has unified 

fonts (thus on same screen are always fonts at same controls with same size/type). 

 

40. Edit permission  
 

 

This super new option allows you to limit actions by other users (administrators) in the following way: you 

set which users (they are entered when you start the software) can change schedule and in which parts. 

This option is related only with years. For example, one person edits 1st year, other 2nd year, etc. It is 

placed at the end of the list in the Locking menu, but it will not show up if such locking is not enabled 

previously. 
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41. Disable database 
 

Although you might have database defined and ODBC connection point to database defined, there is a 

possibility you do not want to interact with the database or with web pages because the file you are 

working on is not in production and/or not intended to be published to database, nor you want that 

reservations made on the web comes automatically into your timetable. 

When database is defined and something is changed since you came into program last time, the history 

log is shown to warn you about the changes. As previously said, you might not want to care about these 

changes while editing current timetable, so there is additional button on history log screen enabling you to 

ignore what happens on the web: 

 

 
 
 

After you click on »Disable database!« button, there will be no any warning from the database and no 

interaction between your PC desktop application and the web pages/database will be made. You can 

freely work on the current file without being afraid of updating the production database. 
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Chapter 4 
Changes between versions 4.0 and 4.99 
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1. Disable and force options 

1.1. Force option 
 

Force is new option and means that the activity is "active" and not red even if it holds a position non-

working days (which are defined in the options for the holidays in the school year details - Settings  

School year details). This option is active only for the current week. All this is presented in following 

pictures:  
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1.2. Disable option 
 

 

Select an activity in the main work space, click the right mouse key and choose Disable.  

Disable (reversed option from Force) is also new possibility and means that the activity becomes red and 

then it does not show any more in obligations. This is used for situations where the activity is in the 

schedule but is blocked due to some implications as lecturer being late, unable to come, group of students 

have some other obligations, and the course is canceled and similar. Therefore, only this one activity in the 

schedule will be disabled by this click without affecting other activities in that day or in the whole week of 

the schedule.  

 
 
 

2. SWP and REF views 

2.1. SWP view 
 

 

This is another great and new option and it is ON when we seek to find other terms available for a 

particular activity to be done if it cannot be done at the time it is placed in the timetable. For this option, 

the condition is to be SWP mode ON and it is located in the down-right corner of the main schedule 

window. It is easier because you don't have to look for other rooms manually (if they are not the same as 

current).  
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When SWP is ON, if you choose by click the activity you want to move to other term, there will appear two 

check boxes at the bottom right corner, under the SWP sign, where: 

 R - Check it if you want software to search other rooms at all (which are different from the present 

one). Uncheck it if you want program to search free terms only in the same room. 

 A - Check it if you want software to search terms in all rooms no matter if they have less seats than 

the present one. Uncheck it if you want software to search only in space with present number of 

seats or more. 

Also, you can set in the Miscellaneous the priority to which the software will search change of term in the 

field "Search rooms until priority" and then you can choose priority from 0 (high) to 9 (low). When 

searching for other term, if you set for example the priority for searching rooms in the Miscellaneous 3, 

software will search new terms in rooms to that priority we previously set. That setting in Miscellaneous 

can be seen here: 
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2.2. REF view 
 
 

In addition to SWP, if the REF is turned on - the software will not search for replacement terms, but it will 

allow you to switch different views of that activity by clicking F5, F6, F7 and F8. Those functions allow: 

 F5 - room view 

 F6 - lecturer view 

 F7 - group view 

 F8 - course view. 



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 117 
 

By clicking of all of these functions, the different view will be shown in the upper - left corner of the 

Timetable window. With this option it is very easy and quick to change different views of that activity we 

click on, and all four views are seen in following picture: 

 
 

3. Set priority to rooms 
 

 

When entering new rooms you have now the new practical option of choosing priorities for taking up 

space, it means that rooms which have priority 0 will be occupied first, after they are occupied than rooms 

under priority 1, then 2, to the number of 9 will be occupied with the same sequence of priority. It is ideal 

for faculty who has more buildings that we first fill the main building, and then others that are further will 

be occupied by the priorities of taking space. When entering a new room - by default priority area is set to 
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0. Rooms with highest priority will be generated first, and then will be generated others with lower priority 

(by hierarchy: 0 - highest priority, 9 lowest priority). Rooms with higher priority will be generated first, and 

than others by descending priority. This option is seen on the picture under:  

 

 
 

 

4. Room’s and lecturer’s obligations window can be widen now 
 

 

Window can be broaden and widen to see more rooms in the list at once. 

  

By double clicking on the blank field by some professor you enable professor to go on the top of the list 

(maybe because we need him/her to be first on the list). 

Window can be broaden and widen to see more lecturers in the list at once.  

 

5. Show only last part of the room name 
 

 

 

Print All Overlays for Groups - check this button if you want software to display all overlays of groups in 

the printed schedule. This option is only possible when all groups are chosen when printing. If it remains 

unchecked, software will not display overlays in Grey color on printed version.  

In this section (Print all overlays for groups) , there is also a setting Show only last part of room name, 

which means as it states, only last several characters of a room name will be shown in printed versions of 

Overlays for groups schedule.  
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The other part of this setting is in wtt.scheme file as ShowOnlyLastRoomNamePartSize=10, where the 

number after equalizer represents the number of last characters of room names that will be shown in the 

schedule. This number is 10 by default, and it can be set to any other number. 
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6. Making breaks/pauses by reservations or in Notepad 
 

You can also set the break at the particular time every working day using reservations. It is possible by 

entering the reservation for each day in each room at the particular time (Edit  Rooms  Room's 

specifications). It is shown below: 
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After you click twice at the empty field there will be new window where you can set all details and 

parameters for breaks: 
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After we set for example break from 15:00 to 15:30 every working day, here's how it will look like for one 

room: 

 

 
 

This procedure is needed to be done in every room in order to have breaks every day in the schedule. 

 

7. Now is possible to choose which subject areas professor belongs to 
 

 

In addition to all the information about the professor you could enter before, now in the version 5 you can 

also determine to which subject areas particular professor "belongs" and is able to teach. When entering a 

new teacher you can determine which subjects he belongs to, and later we can use this option to replace 

the teacher, when a professor in that field is absent from lectures, then with this option you can easily 

substitute teacher by picking some other professor from the same area (from area they both "belong" to). 

This is described on the picture bellow (in this case professor Andrew Altman): 
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On the other side of the screen of course field you can do the same thing - but to pick lecturers who can 

teach that particular course (in this case it is course "Databases"): 
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8. _undefined__undefined_ option 
 

 

It is now also possible to make a special lecturer whose name is _undefined_ and surname also 

_undefined_. This lecturer can be any other lecturer that can teach in that program, subject area or year. 

This option serves so software can find by itself lecturers who "belong" to that subject area and can teach 

some course, but if we pick lecturer _undefined_ _undefined_ for that course. When software finds 

appropriate real lecturer, that lecturer remains in that turn till the end of semester. Simply go to add new 

lecturer and follow these steps: 

 

 
 

And when we are seeking for the lecturer who has time to teach some course or when we simply don't 

know at this moment who can teach it, than this virtual professor finds a lecturer who has more time to 

take this course. When adding new course, we can add undefined lecturer as follows: 
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There is also list of lecturers who are selected as ones that can teach this course, but we want to find the 

optimal one of them who has more free time than others by this "undefined" option. Here is how that list 

looks like with checked professors who could teach this course (in our case "Financial accounting"): 

 

 
 

After next generation, the software will find a lecturer who has more time to teach this course and we will 

finally have a defined professor. Check what happened in our case: after setting _undefined_ _undefined_ 

professor for Financial Accounting, we generated the schedule again and software has found an optimal 

professor for this course instead of undefined one. In this case it is Mr. Altman who, as we can see, had 

more time to teach this course than other two professors.  

 

9. Maximum hours per day for professors and groups 
 

 

 

This general option allows you to set maximum number of hours for all professors and groups in general. 

Also to note, this option can be changed for each group of students or professor in their own specifications 

where by checking a box this option becomes ignored for a certain group or professor. Here is how it looks 

in a Miscellaneous --> Generation: 
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In the professor's or group's specifications, this general setting can be ignored and for a certain 

group/professor it can be set to have other number of daily working hours: 

LECTURER'S SPECIFICATIONS: 
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GROUP'S SPECIFICATIONS: 
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10. Substitutions  
 

 

Substitutions is the separated topic in Tools section where it is possible to make, manage and view 

substitutions for all professors that are unable to attend their lectures and work their hours during one or 

more days, when the whole schedule is already made. You can activate the window of Substitutions by 

clicking F12 function on the keyboard from the main screen of Wise Timetable application. Main window 

of Substitutions looks exactly as the following picture:  
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Absent professor  

Here you can find a professor from the list of all professort who is absent and needs a substitution for his 

activities and obligations during the period of absence.  
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Select period  

Here you can choose a defined period of absence for a certain professor. If none of them matches, choose 

'Other-define dates', and define bellow time and date of your preference. Defaulf setting is 'Today'. 

 

 
 

Time and date can be set in settings shown in the following picture:  
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Search results 

Here is a list of all professors that are available to substitute the professor who is absent.  

Obligations in selected period 

Here are listed all of obligations of absent professor during whole period of absence.  

Show all  

Check this box if yout want software to show all professors that are available for chosen substitution, 

regardless if they teach certain subject or not. If it remains unchecked, only professors that can teach 

chosen subject will be in the list. This option is in down-left part of the Substitution window.  
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Filter 

In this field, you can shorten the search if you are looking for a particular professor and write down his/her 

name and surname, and the software will look for only that professor.  

 

 
 

Together & Substituted 

Together represents the number of all hours that need to be substituted. Substituted represents the 

number of hours that are already substituted. 

 

 
 

Confirm&Next, Confirm, Cancel 

Click on 'Confirm&Next' if you want to save settings for one absent professor and go on settings for other 

absent professor.  

Click on 'Confirm' if you want to save settings for one absent professor. 

Click on 'Cancel' if you don't want to save changes. 

 

 
 



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 133 
 

 

11. Different displays of lecturer's obligations 
 

 

 

There are two options to see lecturer obligations: 

 Choose view by lecturer and a lecturer whose obligations you want to see (in our example it is 

Professor David Cole). Then click the Obligations button in the tool bar. 

 Choose Edit | Lecturers in the menu and a lecturer whose obligations you want to see. Then click 

the Obligations button. 

All the lecturer's courses are listed in the Course column.  

The course type (e.g. lecture, seminar, exercise) is written in the Type column.  

The number of turns that attend this course by this lecturer is written in the Turns column. 

The number of hours per week for all turns is written in the Hours column. E.g. 1-15:2 mean that the 

lecturer has 2 hours per week from the 1st until the 15th week. 1-15:1+1 means that the lecturer has two 

times 1 hour per week from the 1st until the 15th week.  

The number of anticipated hours for the entire school year and, in brackets, the number of allocated hours 

for the entire school year is written in the column all hours. Numbers are decimal because of the 

possibility to have 30 minutes long turns which is half of one hour. 

In the upper right corner of the anticipated hrs field, the number of all anticipated hours for all courses 

that a lecturer gives is written.  

In the Allocated hrs field, the number of the allocated hours for the courses that a lecturer gives and are 

inserted in the timetable is written. 

Click the Print button to print the list of group obligations. 
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The courses painted in yellow have all of the planned hours scheduled in the timetable. For the ones 

painted in white some extra hours need to be scheduled. 

There is detailed view of courses taught by this professor which includes program details, year details and 

subject area details. Those details have the explanatory nature to tell us where exactly belongs that 

particular course. You can turn on or off this detailed view of courses in the WTT notepad file (Program 

files  Wise Timetable  wtt.scheme) in the following way: put equal to 1 if you don’t want detailed info 

of courses or put equal to 0 if you want it though. Here’s how it looks like in the notepad file (in our case it 

is turned off): 
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If detailed view of courses is turned off in notepad file, here is how it looks like without it (in this case we 

have chosen by accident other professor's example - Mr. Ben Murray):  

 

 
 

12. Lecturer’s obligations – displayed turns do not count into the sum 
of all 

 
 

This is another great option which makes now using Wise Timetable even easier. If some of the activities in 

the schedule are disabled, the program will take into account that certain activities are not fulfilled and we 

will deduct the required information without blocking performance, hence we get the exact information 
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about the lecturer's anticipated activities. The following picture shows the situation when there is no 

disabled activity of some professor (in our case Mr. Andrew Altman): 

 

 
 

And the following picture shows the situation where there is one disabled activity of a particular professor 

(in this case the activity of course "Business Design" and same professor Mr. Andrew Altman):  
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13. Every program can have different color attached 
 

 

 

Add, edit or remove programs and the number of years they are taught. Also, now in the new version you 

have the ability assign special color to some program. 

 

 
 

Activities from a particular program can be colored in the schedule with its' own color.  

 

 
 

When you click on the "Color" label in Program's Specifications, the following window shows up (so you 

can choose the exact color of that program): 
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14. _EQ_ option 
 

 

This option is also something new and means that the automatic generation will insert all course types 

with this sign in the same time slot (intentional overlays), in rooms which are defined for the particular 

course type. Allocation in the same time slot will be done for all course types with the sign "_EQ_". For the 

use of this sign you have to define the preferred room. You can set this option in the Settings --> Course 

types, adding new course type with _EQ_ attached at the end, as you can see on the picture bellow: 

 

 



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 139 
 

This allows you to make intentional overlays in some course between two course types, whatever course it 

is - as seen on this picture bellow: 

 

 
 

After all this is finished, the intentional overlay is done, and you can check how that activity looks like in 

the schedule (in our case course is Business Ethics): 
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15. _BL_ option  
 
 

In addition to _EQ_ option, this new option/sign is used for consecutive course segments. This means that 

course types with this signs are scheduled (with automatic generation) in consecutive time slots - 

immediately one after another. It allows you to always schedule tutorials immediately after lectures. This 

setting (as _EQ_ setting) is possible only within the same course but between different course types in that 

course. 
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This allows you to make intentionally tutorial to be held immediately after lecture in some course, 

whatever course it is - as seen on this picture bellow: 
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After this setting is done, generate your schedule so you can check how that activity looks like in the 

schedule (in our case the course is Systems Analysis), tutorials are immediately set after lectures: 

 

 
 
 

16. Send schedules to students/groups by emails 

16.1. Send schedule to all of students  
 

 

The field of group can actually be the concrete name of the student (if faculty has small number of 

students), so every student can get his/her own schedule. When you enter a student, in the field of E-mail 

that is located on the right side of the window - enter his/her e-mail, as seen on the picture bellow. 
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In a case you want to send schedules by e-mail to all of students from some subject area or program (or to 

all subject areas and programs) - than choose the ‘Group’ view of schedule and set the list of students 

from whatever programs and subject areas you want to send e-mails to, as following picture shows: 

 

 
 

After all this is done, go to the File menu. There is option called "Send to Recipient". After click on that 

option, the following window will show up:  
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16.2. Send e-mails to all of groups  
 

The same could be done if we have a lot of students divided into groups, where each group has its' own 

group e-mail. So if you want to send e-mails to all of groups from some subject area or program (or to all 

subject areas and programs) choose the GROUP view of schedule and set the list of groups from whatever 

programs and subject areas you want to send e-mails to, as following picture shows: 

 

 
 

After all this is done, go to the File menu. There is option called "Send to Recipient". After click on that 

option, the following window will show up:  

 

 
 

If you click "Allow", a program will send an email from your outlook e-mail address to each student in this 

list of groups, and each student will receive his/her own schedule and iCalendar incorporated schedule. In 

case you don't want to click YES every time this window appears – we recommend you to download 

freeware application from Wise Timetable installation directory (ClickYesSetup.exe), which clicks 
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automatically YES buttons for you. When installed, it will be available in the toolbar anytime you want to 

turn it on/off - only by double clicking on this icon, as shown further: 

 

 
 
 

16.3. Send individual schedule to one student 
 

 

 

If we want to send schedule to group/student on the main screen and clicking on view in the group, then 

we have also the ability to send schedules via E-mail, individually for each student in different programs or 

subject areas. To individually send e-mails to students, select student as illustrated example Amanda 

Jones. 

 

 
 

Then click on the main menu to "File" and then click "Send to recipient", and application Wise Timetable 

sends automatically E-mail to a selected student.  
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The same procedure is when you want to send e-mail with schedule to only one particular group. To 

individually send e-mails to groups, select group as illustrated example BAM1-4. 

 
 

Then click on the main menu to "File" and then click "Send to recipient", and application Wise Timetable 

sends automatically E-mail to a selected student/group.  
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The same window will appear as you send e-mails to all of students or groups. Click Allow and 

student/group you sent you e-mail to will receive it together with the iCalendar.  

 
 

In case you don't want to click YES every time this window appears – we recommend you to download 

freeware application from Wise Timetable installation directory (ClickYesSetup.exe), which clicks 

automatically YES buttons for you. When installed, it will be available in the toolbar anytime you want to 

turn it on/off - only by double clicking on this icon, as shown further: 
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16.4. Choose option 
 

 

There is also new function where you can choose particular number of students or groups to whom you 

want to send schedule via e-mail. All you do is clicking on "Choose" option in the list of offered students / 

groups and choose only those to whom you need to send schedule, as pictured bellow:  
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After clicking "Choose" in the list of groups/students, the following windows (depending is it group 

choosing or student choosing) will show up: 

 

 
 

Then click on the main menu to "File" and then click "Send to recipient", and application Wise Timetable 

sends automatically E-mail to selected students/groups: 

 
 

Attaching iCalendar together with schedule is possible only if iCalendar is checked in the miscellaneous 

options (Settings  Miscellaneous), which you can also check in the following picture. 
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17. Checkboxes – check days when a course can be performed 
 

 

 

In the new version of our software you can also set option that regulates which days are allowed to take a 

particular course, so each turn will be generated only at days you checked. Those are check boxes at the 

bottom of the screen when editing courses, shown on the pictures bellow - so you can check days in which 

you want this course turns to be generated. But for example if you choose only Monday to generate some 

turn and set 1+1 formula of duration at the same time, one turn will be left unallocated because you have 

chosen only one day to generate this course and formula 1+1 means two turns in two different days in a 

week. 

 

 
 

This option can be different for each turn; it is not set for the whole course. Therefore you may notice that 

it will be enabled to be checked only when you click on a particular turn in that course. It is different for 
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each professor - for example if some professor prefers to have his/her turns in some particular days in a 

week. This option has all days in week checked by default.  
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18. Course code setting 
 

 

There is also the possibility to enter a code for each course in the following field shown in the picture: 

 
 
 

You are allowed to turn on or off the display of these codes in the schedule (Program files  Wise 

Timetable  wtt.scheme) in a way to turn equal to 1 if you don't want it to be shown and equal to 0 if you 

want course codes to be shown in the schedule. Here's how it looks like in the notepad (in our case it is 

turned off): 
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19. New options in exports 
 

 

 

There is a green button in this section called Edit PDF templates, and by clicking on this button you can 

include or exclude labels in PDF template for e-mails. Here's how it looks like: 

 

 
 

Print lecturer - check this button if you want professor's name in the printed schedule of groups. Here's 

how it looks like when printed: 

 

 
 

If you leave this option unchecked, professor’s name will not be displayed in the printed schedule. 
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Print All Overlays for Groups - check this button if you want software to display all overlays of groups in 

the printed schedule. This option is only possible when all groups are chosen when printing. If it remains 

unchecked, software will not display overlays in Grey color on printed version.  

 

20. iCalendar  
 

 

Choose between CSV and PDF format. In a PDF format, you can choose between the schedule being 

ordered for the whole week or by day. Also, you have a brand new option to include iCalendar in your 

email and incorporate all of professors' obligations with those from Wise Timetable schedule. The same 

will happen if you choose to send e-mails to each student, if you click on the "Attach iCalendar File to E-

mail", each student will get his/her own iCalendar to be incorporated in their other schedules. 
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Please note that iCalendar is compatible with every kind of online calendars as Google calendar, Outlook 

and others. It is than easier for professors and students to have the whole schedule of their obligations in 

their own calendar application of choice. 

 

21. Start hour  
 

 

There is also a very practical new option called "Start Hour" and with it we have the ability to determine 

at what time to start performing the selected subject/course, as seen on the picture bellow. 

 

 
 

When we click on this option in editing courses, new window shows up to choose at what time we want 

this turn to start – whatever day is chosen when the activity is actually generated. If we for example 

choose 10:30, that turn and that professor will teach only starting from that time. It is seen in the 

following picture:  



Wise Timetable Release notes 
 

Copyright ©Wise Technologies ltd. 156 
 

 
 

This option is by default set to (None) – which means the activity can be placed during the whole day. 

 

22. One segment duration 
 

 

 

With this brand new option we set how long the so called "double" segment is. It has an impact on almost 

all displays of the obligation of lecturers, groups, subjects. It has an immediate impact on the display when 

editing subjects and this option is easily seen in the picture bellow: 
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Segments are seen on the main schedule window as this: 

 

 
 

It is possible to make segment duration to any number of minutes so we can divide time however we need 

to.  

For example, here we have “one segment duration” of 60 minutes.  
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After that, in some course specifications (in our case course is "Databases") we entered that tutorials have 

3 x 60 duration.  

 

 
 

And therefore, after next generating this activity has taken three segments of 60 minutes in the schedule. 
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But for example, if we have “one segment duration” of 30 minutes, the situation will be slightly different. 

 

 
 

After that, in some course specifications (in our case course is "Databases") we entered that lectures have 

3.5 x 30 duration.  
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After next generating of schedule or that course, this activity will take 3.5 double segments and it will be 

possible because we turned on the one segment duration of 30 minutes and it will look like this in the 

schedule: 
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23. WebView equipment  
 

 

 

There is also a setting by which some of the rooms are "highlighted" on web page of schedule. Highlighted 

means that they are marked as ones that can be viewed in this special way in order to have a quicker look 

of what is performing in those rooms. In order to enable this option in any of rooms, first of all we have to 

add new equipment in equipment section written as WebView and confirm, as seen below: 

 

 
 

 room_zoom option 

 

After setting in Equipment Settings at Settings in PC application Wise Timetable special equipment named 

"WebView", rooms with that equipment defined in themselves can be shown in a "highlighted" way on 

website, which means they can be more easily tracked and seen (if we are really interested to check those 

rooms primarily and quickly each time). Highlighted means that they are marked as ones that can be 

viewed in this special way in order to have a quicker look of what is performing in those rooms.  

This is how it looks in Equipment settings which are than dedicated to rooms that we wish to have this 

“Room_zoom” option: 
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After that is done, rooms in which this "WebView" option is set will be highlighted and specially presented 

on the presentation pages, and this option is called "Room Zoom". Here is how it looks on the page of all 

rooms listed with all activities held in them: 

 

 
 

By clicking on one of those highlighted activities, the following additional window will appear, with all 

other details regarding that activity as duration, description and teacher. 
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24. Shortcuts for generating passwords on website 
 

 

NOTE for administrators - SHORTCUTS: 

If password entering is enabled for groups, sometimes it is very time-consuming to generate manually all 

of passwords for every group, especially if there are a lot of them.  

In case that password for groups is ON, and you want to generate passwords for groups of students who 

still don't have it, when entering PC Wise Timetable application, click SHIFT + F12 and automatically those 

who don't have passwords will be generated.  

But if you enter SHIFT + INSERT, program will generate passwords for those who don't have it, and also for 

those with existing passwords, and those will be deleted. So in that case you will generate passwords for 

every group, no matter if the group had or did not have one. 

 

NOTE for administrators – SHORTCUTS: 

If password entering is enabled for lecturers, sometimes it is very time-consuming to generate manually all 

of passwords for every professor, especially if there are a lot of them.  

In case that password for lecturers is ON, and you want to generate passwords for lecturers who still don't 

have it, when entering PC Wise Timetable application, click SHIFT + F12 and automatically those without 

passwords will be generated.  
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But if you enter SHIFT + INSERT, program will generate passwords for those lecturers who don't have it, 

and also for those with existing passwords which will be deleted automatically. So in that case you will 

generate new passwords for every lecturer, no matter if he/she had or did not have one. 

 

25. Print one day 
 

 

Print One Day is new option and prints only lecturers' schedules for only one selected day. Choose view by 

lecturer and the lecturer whose schedule you want to print. The following window opens: 

 

 
 

Select the period for which you want to print schedules (separated for each day) and click Confirm. Here's 

how it looks like when printed (in our case it is Professor Andrew Altman): 
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26. New option in conflict analysis window 
 

 

 

Select Analysis | View conflicts in the menu to see all conflicts in the timetable. There are several new 

practical options - as one to include also overlapping web reservations in the list of conflicts.  

 

 
 

Show selectable - check this button if you want to see overlays or conflicts of optional / selectable curses 

and turns. This could be also an intentional overlay, because it is selectable course, students and groups 

can choose between many selectable courses and more groups can participate to lectures or tutorials of 

this kind of course. 

Find student overlaps - check this button if you want to see student overlaps. This is used when students 

are set by their names and surnames instead groups, so we can see where a particular student participates 

at what time. The same is possible when there are groups of students, and overlaps of groups are possible 

if more groups attend the same lectures or tutorials, especially in selectable courses. 

Overlapping web reservations - check this button if you want to see overlaps of reservations made on the 

web. For example you can check if two professors reserved the same room at the same time.  
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You can also control the analysis of conflicts in the WTT file called wtt.scheme (Program files  Wise 

Timetable  wtt.scheme). It opens in the notepad and you can enable or disable the appearance of the 

"Find student conflicts" by: put equal to 0 if you don't want it to appear in the window of conflicts, and put 

equal to 1 if you want it to appear in the window of conflicts, than save the change. Here's how it looks 

like in notepad:  

 

 
 
 

27. Optimization window has some new features 
 

 

You can optimize the automatic generation process by choosing the programs and the years which you 

want to generate and by setting the percentage of deviation for the number of students and the number 
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of seats in a room. Set the percentage of deviation means that you allow the program to occupy a room 

with fewer seats than there are students in the group or to allow the program to occupy a bigger room for 

a smaller group of students. Also, you can choose all of programs to optimize them; you can click "choose 

none" button or just click the particular ones from the list.  

 
 
 

28. Magnetic board 
 

 

 

Besides the automatic way of making schedules in Wise Timetable application, there is also provided a 

traditional way of making handmade schedules inside the Wise Timetable software. All changes made in 

this software match with previously made automatic schedule, and it is not needed to generate timetables 

after some changes have been made in the Magnetic board. After saving changes in Magnetic board, they 

automatically stay inside the schedule.  

Magnetic board is a special part of Edit section where it is possible to see the whole schedule for all 

professors. It is made according to traditional way of making schedules, before computers and internet 

even existed. Magnetic board is a special table with magnets and has axis with all professors listed and axis 

of days in a week. Little magnets represent each group of students and they can be moved across the table 

to match time and professors and have better overview of all activities inside one week. It is awesome 

because magnets cannot be set over each other so there will be no overlaps. Also, administrator has a 

good view of all activities for groups. Wise Timetable application gives even this kind of perspective on the 

whole schedule.  
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The window of Magnetic board is presented in the following picture: 

 

 
 

+ and - (plus, minus) signs can be clicked to show more or less activities inside one day in a week. Grey 

quadrant can be moved left or right in order to navigate through all groups inside that one day in a week. 

It can be also done with arrows on the both sides for one day.  

 

 
Resize all to 

 

This is a special up-list menu where you can resize the whole magnetic board to how many groups you 

want to.  
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Start all at 

This is a special up-list menu where you can set the time from which the whole schedule will start every 

day in a week that is presented on Magnetic board. 
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Cancel or Accept 

Click Cancel if you don't want to save changes that you made on a Magnetic board. 

Click Accept if you want to save changes that you made on a Magnetic board. 

 
 

 

 

29. Two simultaneous databases for recording data 
 

 

Data can now be recorded in two different databases simultaneously – which helps a lot in organization of 

the schedule. The first one is production database (which can be seen by students, professors in public) 

and "alternative" or a testing database only seen by admin and people that admin chooses - it is database 

for the probe or in the case when the schedule is still in the process of making for the next semester 

(through this phase it could be shown to professors to check their opinions etc). It is shown at the 

beginning of the Data menu, as you can see in the following picture: 
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you can check these options in the WTT file called dbsettings.ini (Computer  Program files  Wise 

Timetable  dbsettings.ini) - first two are production databases and other two alternative databases, as 

you can check in the following picture: 

 

 
 


